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Notice

The material contained in this manual, and in the online help for the software used to support this instrument,
is believed adequate for the intended use of the instrument.  If the instrument or procedures are used for pur-
poses other than those specified herein, confirmation of their suitability must be obtained from TA Instruments.
Otherwise, TA Instruments does not guarantee any results and assumes no obligation or liability.  TA Instru-
ments also reserves the right to revise this document and to make changes without notice.

TA Instruments may have patents, patent applications, trademarks, copyrights, or other intellectual property
covering subject matter in this document.  Except as expressly provided in written license agreement from TA
Instrument, the furnishing of this document does not give you any license to these patents, trademarks, copy-
rights, or other intellectual property.

TA Instruments Operating Software, as well as Module, Data Analysis, and Utility Software and their associ-
ated manuals and online help, are proprietary and copyrighted by TA Instruments.  Purchasers are granted a
license to use these software programs on the module and controller with which they were purchased.  These
programs may not be duplicated by the purchaser without the prior written consent of TA Instruments.  Each
licensed program shall remain the exclusive property of TA Instruments, and no rights or licenses are granted to
the purchaser other than as specified above.
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Important:  TA Instruments Manual Supplement
Please click on the links below to access important information supplemental to this
Getting Started Guide:

• TA Instruments Trademarks

• TA Instruments Patents

• Other Trademarks

• TA Instruments End-User License Agreement

• TA Instruments Offices
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Notes, Cautions, and Warnings
The following conventions are used throughout this guide to point out items of importance to you as you read
through the instructions.

A NOTE highlights important information about equipment or procedures.

A CAUTION emphasizes a procedure that may damage equipment or cause loss of
data if not followed correctly.

A WARNING indicates a procedure that may be hazardous to the operator or to the
environment if not followed correctly.
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Welcome
Thank you for purchasing TA Instruments Rheology Advantage.  Rheology Advantage makes it easy for you to set
up and control the various instruments that are available from TA Instruments through the use of tool bars,
menus, and windows.  The Instrument Control program is used to run experiments on your rheometer and
gather data files.

If you need help or information while using your Rheology Advantage software, online help is available as
described in the next section.

Getting Help
Everything that you need to
know about using the Advan-
tage software is now online.
This online information
should be your primary source
of information to help you use
the programs.  See the figure to
the right for an graphical
representation showing the
location and types of help that
are available.

   Screen Tips
ScreenTips show information about different elements on the screen. To see a ScreenTip for a
dialog box option, click the question mark and then click the option. (If the dialog box doesn't
have a question mark button, select the option and then press the F1 key.)  To see information
about a tool bar button, position the mouse pointer over the button until the text appears
(shown to the right).

Contents and Index
You can get Help using methods similar to the Windows®  help system. Click Contents and Index on the Help
menu. Click the Contents tab to scroll through a table of contents for the Help file. Click the Index tab to search
for topics by using an index of subjects. Click on the Find tab to use full-text search and look for specific words
or phrases.

Chapter 1
Introducing Rheology Advantage
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Adding Annotations
You can add your own notes to the help system pages by using the Notes button. Any topic that has been
annotated with notes will have a paper clip icon  to the left of the topic title.

Navigating the Help System
Use the following icons to access more information when using the Rheology Advantage online help:

Provides a jump to more information.
Shows a popup with more information or an example.
Performs an action for you in the software.

Printing a Manual
During installation, you have the option to display one or both the icons for the TA Instrument Manuals and
TA Software Manuals.  These shortcuts allow you to access the library of available printable manuals for both
hardware and software, respectively.

Changing the Help's Font Size
Follow these steps to change the font size for the current help file:

1. Open the desired help file.  In an open Help topic window, click Options.

2. Select Font and then click Small, Normal, or Large.

Printing a Help Topic
Help topics can be printed by following these instructions:

To print one topic:

1. Open the desired help file and open a help topics. In the Help topic window, click Options.

2. Click Print Topic.

To print more than one topic:

1. Select Help Topics.

2. Select the Contents tab, then click on the book icon for the selected group of topics.

3. Click the Print button.
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Overview
Five large buttons (tabs) control what is shown in the main display area of the Rheology Advantage Instrument
Control program (shown below):

Button Description

Instrument Status Provides control over the basic instrument functions.  This is a good place
to manually assess a sample prior to procedure development.

Geometry Shows the currently loaded measuring geometry and allows it to be
edited.

Procedure Shows the currently loaded procedure and allows it to be edited.

Notes Provides sample information including density and optional user
variables

Realtime Plot If a measurement has been started, this  displays the data graphically as
well as  numerical values for the last point.

Instrument Status
Geometry

Procedure
Notes

RealTime Plot
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Standard Tool Bar
The tool bar (shown below) can be used for many of the same functions that are found in the menus.  The table
provides a list of the buttons available and a brief description of each one.

Tool Bar Buttons Description

New, Open, Save These buttons are multifunctional in that they can apply to the geometry,
procedure, or notes depending on the active tab.

Undo Click the Undo button to reverse the last command or delete the last entry and
restores the previous text.

Procedure Wizard Choose this button to start the wizard that will guide you through the process
needed to set up a procedure.

Add and Delete Step These buttons insert or delete the selected step(s) in the procedure.  Changes
can be made to the procedures even during the experiment as long as the step
has not been started.

Manual Oscillation Click this button to perform single point oscillation measurements.  This is a
good way to assess a sample prior to procedure development.

Run Data Module Choose this button to switch to the data analysis program.

Analyze Click this button to send the current data
Results from the realtime plot to the data analysis program.

About Select this to show the current program version and copyright information.

Help Topics Click to access online help.

What's This Help Position cursor on desired area, then click this button to access interactive help.

New

Open

Save

Undo

Procedure
Wizard

Add Step

Delete
Step

Manual
Oscillation

Run
Data
Module Analyze

Results

About

Help

What's
This Help
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Experiment Run Tool Bar
The Experiment Run tool bar is used to control the experiment after setup.  The buttons found on the tool bar are
briefly described below.

Tool Bar Buttons Description

Run Starts the experiment.

Stop Stops the experiment.

Abort Step Terminates the current step and moves on to the next step in the procedure.

Abandon Point Skips the current point in the step without
(Steady State Flow) saving it to the data file.

Accept Point Overrides the steady state conditions in the
(Steady State Flow) step and accepts the point.

Run Stop Abort
Step

Abandon
Point

Accept
Point
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Configuring the Software
The Rheology Advantage software is configured with certain options in place when it is installed.  This section
tells you how to make various configuration changes to the software after installation.

Setting the Default Options
The following instructions provide information on setting up the desired default options to be used for the
program:

1. Select Options/Settings from the menu.

2. Click on the View tab.

3. Click on the Defaults button.

4. Click the Close button.

5. Select Experiment from the menu.

6. Click on Graph, then select Change variables...

7. Click on the set to defaults button.

NOTE: Steps 6 and 7 only apply to the active test type, i.e., equilibrium flow etc.  You must repeat this for each
test type as required.

8. Click the OK button.

Viewing the Default File Locations
To view the directory that was last used for particular file types follow these directions:

1. Select Options/Settings from the menu.

2. Click on the Directories tab.

NOTE:  Directories can only be viewed using this method.  To change directories you need to use the Save As
function.
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Using the Tool Bars
Tool bars give you quick access to various functions of the software. You can move them about the screen or
"dock" them to the program screen.  To find out the function of each button on a tool bar, hold the mouse cursor
over the appropriate button until a pop-up text message appears.

Moving a Tool Bar
1. Click the move handle,  , on a docked tool bar or click the title bar on a floating tool bar .

2. Drag the tool bar to a new location.  If you drag the tool bar to one edge of the program window, it becomes a
docked tool bar.

Show/Hide a Tool Bar
1. Select Options from the menu.

2. Click on General.

3. Click on the View tab.

4. To show a particular tool bar, select (check) it on the list . To hide it, de-select it.

NOTE:  To quickly hide a floating tool bar, click the close (x)  button on the tool bar.

Changing the Button Size
1. Select Options from the menu.

2. Click on General.

3. Click on the View tab.

4. Select Large Buttons to increase the tool bar size.
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Understanding the Menus
The following tables provide a description of the various menus used in the Rheology Advantage Instrument
Control program.

File Menu
Refer to the following table for a brief description of the File menu:

Menu Item Description

Open Session Select this menu item to open a previously saved session.  A session contains
information on the geometry, procedure, notes, and instrument options.  A
session file can be used as a desktop short cut to automatically configure your
rheometer on starting the software.

Save Session This option saves the current geometry, procedure, notes, and instrument options
in a single file.

Save Session As This option also saves the current geometry, procedure, notes, and instrument
options in a single file and it allows you to assign a new file name to the session
file.

Load Options Select Load Options from the menu to load the previously saved instrument
options.

Save Options As Use this function to save the current instrument options to a file that can be
recalled at a later date.

NOTE:  For information on menus not discussed here, refer to the remaining portion of this manual.

Instrument Menu
Refer to the following table for a brief description of the Instrument menu:

Menu Item Description

Oscillatory Mapping This is an advanced feature used to improve low torque/displacement oscillatory
data. Refer to the document New Features in Rheology Advantage 4.1 for more
information.

Settings This function provides information on the current instrument type and communi-
cations.

NOTE:  For information on menus not discussed here, refer to the remaining portion of this manual.
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Experiment Menu
Refer to the following table for a brief description of the Experiment menu:

Menu Item Description

Graph This function is used to change the properties, variables, and log/linear settings
for the realtime plot.  These functions perform in a fashion similar to the Rheol-
ogy Advantage Data Analysis program.  Please refer to the Rheology Advantage
Data Analysis Getting Started Guide for further information.

Additional Variables Select to access variables for the numerical data shown as part of the realtime
plot window.

Previous Results Used to display the last results file of the same procedure type or to select up to
two control files.

NOTE:  For information on menus not discussed here, refer to the remaining portion of this manual.

Options Menu
Refer to the following table for a brief description of the Options menu:

Menu Item Description

Instrument The AR 2000 automatically reads the currently
Temperature installed temperature system.  For other rheometers it is necessary to select the

correct system using this function.

ID Select this option to provide information on the system setup that may be
requested by Service.

Experiment Allows you to access settings that affect how data is stored and flagged as
erroneous.

Settings This function provides access to SI/cgs switch, range bars, language, and other
global settings.

NOTE:  For information on menus not discussed here, refer to the remaining portion of this manual.
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Before you can run a test on the rheometer, you will need to prepare the instrument for operation.  Preparation
involves proper calibration of the rheometer and selection of the appropriate geometry as directed in this
chapter.

Calibrating the Rheometer
Your TA Instruments rheometer is a piece of precision scientific equipment and, as such, needs to be main-
tained to a sufficient standard so that operators of the instrument can be confident the data obtained from the
instrument is correct.

A rheometer works with the following fundamental physical properties:

• Torque
• Displacement/Speed
• Temperature
• Gap
• Frequency
• Phase shift.

Since much of the rheometer calibration can only be adjusted using specialist tools, it is recommended that the
instrument be given a full calibration/verification service at least annually.  Although you can not perform a
full calibration of the rheometer yourself, you can still monitor the performance and perform verification tests.
It is recommended that you adopt some form of good laboratory practice (GLP) and establish a routine for
monitoring the performance of the rheometer.  The following areas should be considered:

• Verification of “System calibration factors.”

— Instrument inertia.
— Measuring system inertia.
— Rotational (torque) mapping.
— Air bearing friction.

• Verification of Temperature calibration.

• Verification testing with a rheology standard  (flow/creep/oscillation tests)

This chapter provides information that you will need to get started calibrating your rheometer.  Refer to the
online help available in the program for more details.

Chapter 2
Preparing the Instrument
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Calibrating Inertia
In an ideal world, whenever a torque was applied by a rheometer, it would act solely upon the loaded sample
and nothing else.  In practice, however, the non-zero moments of inertia of the rheometer spindle and measure-
ment geometry mean that some of the applied torque is being used to accelerate or decelerate these mechanical
components (until steady state is reached.)

A correction needs to be made to the torque value to reflect more accurately the conditions that the sample is
undergoing.  The amount of correction applied is based upon the calibrated values of the instrument and
geometry inertia. In the oscillation mode, the correction is made automatically.  In the flow mode, however, the
correction can be toggled on or off as necessary.  Flow inertia correction is more likely to be needed when low
viscosity materials are being measured using fast ramps over a wide shear range.

Calibrating Instrument Inertia

Under perfect circumstances, the inertia value of the rheometer should not change with time.  Running a
calibration check on this value therefore gives a good indication of the performance of the rheometer.  If you
notice a continual drift of this value, check the quality of the air used as it could be indicative of a poor quality
supply.

To calibrate the rheometer inertia, follow these steps:

1. Select Options from the menu.

2. Click on Instrument...

3. Click on the Inertia tab.

4. Ensure that there is no measuring system attached to the rheometer.

5. Click on the Calibrate button.

6. Follow the steps in the calibration wizard.

NOTE:  You can also type the value in manually at step 3, if required. (For example, you can type in a specific
value to restore the calibration to a known calibration state.)

Measuring System Inertia

The value of the inertia for each measuring system differs because they all have been uniquely engineered and
could have different masses. It is important to calibrate the inertia value for each geometry, particularly if high
frequency oscillations are being used, or if low viscosity fluids are being measured.

Follow these steps to calibrate the measuring system inertia:

1. Select Geometry from the menu.

2. Click on View.

3. Click on the Settings tab.

4. Ensure that the correct measuring system is attached to the rheometer.
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5. Click on the  Calibrate button (Geometry inertia).

NOTE:  You can also type the value in manually at step 3, if required. (For example, you can type in a specific
value to restore the calibration to a known calibration state.)

Performing Flow Inertia Correction

When a stress is applied to a sample it will move and
continue to move while that stress is applied.  If the stress is
subsequently removed, the sample will stop moving, but not
instantaneously.  It requires a finite time to respond to this
change in stress.  This lag time is due to inertial effects and
its magnitude is entirely sample dependent.  In flow experi-
ments, the effect of inertia is more pronounced in low
viscosity fluids.  Inertial effects manifest themselves in flow
as the appearance of apparent thixotropic loops when a
standard UP and DOWN flow curve is carried out.   Con-
sider the graph shown to the right.

You could interpret this graph as a flow curve on a thixotro-
pic sample, highlighted by the presence of the hysteresis
loop.  However, the fact that the the DOWN curve (B) crosses
the x axis alerts us to the fact that this apparent thixotropy is
actually an inertial artifact and that the down curve intercepts the y-axis below the origin.

The inertial correction feature available in the AR Rheometer
eradicates such artifacts.  It is a straight-forward toggle ON/
OFF option that you can access using the software. (See the
online help available for the software.)

Using the same sample as above, but measuring with the
inertia correction ON, yields the results shown in Figure 2 to
the left.

This now shows a Newtonian response, which is as expected.
This inertia correction only needs to be active when low
viscosity materials are being measured.

Using the Inertia Correction

The inertia correction is used automatically when carrying out oscillation tests.  To use inertia correction in
Flow mode:

1. Select Options from the menu.

2. Click on Experiment.

3. Select the Flow tab.

4. Ensure that both the Instrument and Geometry inertia have been calibrated.

5. Ensure that the Inertia Correction option is selected.

6. Press the OK button.

Figure 1
 Flow Curve without Inertia Correction

Stress

Shear Rate

Figure 2
Flow Curve with Inertia Correction
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Rotational Mapping
Due to the micron tolerances needed to make an air bearing work, any bearing will have small variations in
behavior around one revolution of the shaft. They are consistent over time unless changes occur in the air
bearing.  By combining the absolute angular position data from the optical encoder with microprocessor control
of the motor, these small variations can be mapped automatically and stored in memory.

To create a map, the program rotates the air bearing at a fixed speed, monitoring the torque required to maintain
this speed through a full 360° of rotation. The number of points in the map (and the speed of rotation used) is
dependent upon the mapping type used.  These variations can then be allowed for automatically by the micro-
processor, which is in effect carrying out a baseline correction of the torque.  This results in a very wide operat-
ing range of the bearing without operator intervention—a confidence check in bearing performance.  For
maximum accuracy at the lower torque end of the rheometer, it is recommended that the mapping be performed
each time a new measuring system is used.

To perform a rotational mapping:

1. Attach the required measuring geometry to the rheometer.

2. Load the correct Geometry file into the software.

3. Set the mapping type as follows:

a. Select Instrument on the menu.

b. Select Rotational Mapping.

c. Select the Bearing mapping required [standard , fast, precision, or extended (AR 2000 only)—see
"Mapping Types" on the next page for more information.]

d. Select the number of iterations.

e. Click Perform Mapping button—see "Mapping Types" on the next page for more information.

Mapping Types

The following mapping types are available in the Instrument Control program:

• Standard mapping takes approximately 1 minute to complete.  It is suitable for day to day use.

• Fast mapping takes approximately 45 seconds to complete.  Less mapping points per revolution are used
than standard or precision mode.  It is around half as accurate as Standard mode.  It is suitable for day-to-
day use where low-end accuracy is not so much of a problem.

• Precision mapping gives the most accurate calibration of the rheometer but takes around 2 minutes to
complete. This mode is approximately twice as accurate as Standard mode.

• Extended mapping (AR 2000 Only) gives the best low torque/velocity performance.
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Automatic Prompting for Mapping

The program can be set so that it will automatically prompt you to perform a mapping each time you change the
installed measuring geometry.  Follow these steps:

1. Select Options on the menu bar.

2. Select Settings.

3. Click on the Mapping tab.

4. Ensure that Prompt user to map when geometry changed option is selected.

5. Press the OK button.

Setting the Number of Mapping Iterations

For optimum performance at very low torques (<10 µN.m) multiple mappings can be performed. Generally, you
will see little further improvement in performance after three consecutive mappings.  To select the number of
mapping iterations, use the following procedure:

1. Select Options on the menu.

2. Click on Settings.

3. Click on the Mapping tab.

4. Enter the number of mapping iterations required.

5. Click on the OK button.

NOTE:  Extended mapping does not support multiple iterations.
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Calibrating for Friction
An air bearing is used to provide virtually friction free application of torque to the sample.  However, there will
always be some residual friction.  With most materials this friction is insignificant, but in about 1% of low
viscosity samples, this inherent friction causes inaccuracies in the final rheological data.  To overcome this, the
software has an air bearing friction correction that can be activated, if required.

Since each air bearing is custom designed and engineered, they are each unique.  This means that the correction
factor will also be unique to each bearing.

Determining the Friction Correction Factor

If you wish to apply the air bearing friction correction, you must first calibrate your bearing.  This procedure
should be carried out monthly if you use the option frequently.  It can be affected by changes in the air supply
so you are advised to ensure your air supply is stable.  To determine the air bearing friction correction factor,
use the following procedure:

1. Make sure the instrument inertia has been calibrated.

2. Attach the geometry of choice to the rheometer.

3. Enter the relevant geometry details via the software and make sure it has had its inertia calibrated.

4. Select Options from the menu.

5. Select Instrument.

6. Click on the Miscellaneous tab.

7. Click on the Calibrate button and follow the wizard.

Calibrating the Temperature
A full calibration of the temperature control system should only be carried out by an authorized TA Instruments
representative.  It is possible, however, to verify and adjust the calibration using a procedure such as given
below.

1. Set the rheometer to give a value of 100°C.

2. Using a certified digital thermometer, measure the actual plate temperature.

3. Set the rheometer to 0°C.

4. Measure and note the actual temperature again. (Ensure that the temperature has stabilized.)

5. Repeat the process of setting and measuring temperatures, if more accuracy is required.

6. Determine the values for offset and span (see the next section).

7. Select Options from the menu.
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8. Select Instrument.

9. Click on the Miscellaneous tab.

10. Click on the Offset entry for the selected temperature controller and enter the value obtained from the
graph above for offset.

11. Click on the Span entry for the selected temperature controller and enter the span value obtained from the
graph.

12. Click on the OK button to set these values on the rheometer.

Finding the Offset and Span Values

The temperature control devices on the rheometer can be independently calibrated by calculating a span and
offset.  It can be used in two ways.

Offset & Span Calibration Method #1

Set a low and high temperature [ST1 & ST2] and measure the actual temperatures by another (reference)
technique [RT1 & RT2].  If this is done at just two temperatures covering the temperature range of interest the
calculation of span and offset can simply be done as follows:

Span = [ST2 - ST1]/[RT2- RT1]
Offset = ST2 - [RT2*Span]

If you want to make a more accurate calibration, you will need to measure at more than two temperatures.  In
this case, it is easier to use a spreadsheet (such as Microsoft® Excel.)   Enter data into a table, then use the
graph Wizard (or similar) to create an XY scatter graph.  Insert the "best fit" line by right clicking on a data
point.  An example is shown below.

Set Temperature Measured Temperature
50 53
150 155
200 206

From the equation of the best fit line [y = Slope*x + Intercept] calculate the span and offset as follows:

Span  = 1/Slope  = 1/1.02 = 0.98
Offset  =  -Intercept/Slope = 2/1.02 = -1.96

M
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Offset & Span Calibration Method #2

The second way to calibrate the span and offset is to use a "standard" oil, which hopefully covers the tempera-
ture range of interest.  Measuring viscosity at the set temperature doesn't help you.  You need to adjust the set
temperature until you get the certified viscosity value—some trial and error may be required.  Note this tempera-
ture as the adjusted set temperature [AST].  For a two-point calibration calculate the span and offset as follows:

Span = [AST2- AST1]/[ST2-ST1]
Offset = AST2 - [ST2*Span]

If you have more than two points, use a spreadsheet as shown in this example.

Set Temperature Adjusted Temperature

50 45
150 144
200 192

In this case there is no need for more calculation
as:

Span = Slope = 0.98

Offset =  Intercept = -3.86
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System Verification
Although you cannot calibrate the rheometer yourself, you can check that the instrument is functioning prop-
erly by measuring the viscosity of a certified standard Newtonian oil. If you get a greater than 5% error in the
reading, there is a possibility that your rheometer needs some attention from a TA Instruments Service Engineer.
It is recommended that this verification check be performed at least on a monthly basis.

Carry out the following experiment.

1. Attach a 60 mm 2° cone to the rheometer. (This is the preferred geometry, if you do not have one, use the
largest cone available to you.)

2. Install the measuring geometry into the rheometer.

3. Set the zero datum point for the measuring system.

4. Carefully load the sample, ensuring correct filling.

5. Carry out a "2-minute" flow test over as wide a range as possible.

6. Determine the Newtonian viscosity. If this value is more than 5% different from the certified value repeat the
experiment. If the results are still in error, call your local TA Instruments office for advice.

The following are sources of error that can be checked:

• Over or under filling of the gap—ensure that you have established a standard method of sample loading.

• Temperature error—verify the temperature of the measuring geometry against a certified digital
thermometer.

• Gap setting—ensure that the gap was correctly zeroed at the operating temperature.

Setting and Controlling the Gap
You may recall that the shear rate obtained in any experiment is due in part to the gap between the measuring
systems used on the rheometer.  Because of this, the accuracy of the way the gap is set is of critical importance to
the accuracy of the results obtained.  Whenever you change the measuring geometry on the rheometer, it is
recommended that you ensure that the zero point or "datum" is correctly set.  The rheometer can be made to
obtain this setting automatically.  Note that if the gap is incorrectly set, the data obtained will be in error.  The
actual gap that can be used depends upon the measuring geometry.

• For parallel plates, any gap (within reason) can be set.

• For cone and plates, the gap is determined by the cone truncation.

• Most other measuring systems also have a fixed gap setting.

When the test procedure calls for the temperature to change with time, the gap setting will change if the thermal
expansion/contraction of the measuring system is not compensated for.   The software, therefore, contains a
thermal compensation mode that can be activated as required.
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Thermal Compensation
When performing rheology testing, it is important to be able to compensate for changes in the temperature
during the test measurement.

Why Use Thermal Compensation?

One of the features of the "Automatic Gap Setting" (AGS) facility is the ability to compensate for changes in the
gap due to temperature changes during the measurement.  The compensation is an active correction made to the
gap—the rheometer physically moves the rheometer head to ensure that the actual gap remains constant.

The effects of expansion/contraction of the metallic parts of the rheometer can be eliminated by calibrating and
then activating the thermal gap compensation factor in the software.  For the most accurate compensation, you
must obtain a value for each different measuring geometry and temperature module used.

Calibrating the Compensation Value
Follow the steps below to calibrate the compensation value:

1. Select and attach the required measuring geometry.

2. Click on the Settings tab of the Geometry template.

3. Click on the Calibrate button and follow the wizard.

Approximate Values

The table below gives an approximate guide to compensation values. These will generally give an acceptable
performance for the gap compensation. It is only when you are working with extremely small gaps/cone angles
and require the highest degree of precision, that you will need to calibrate these values.
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Compliance
When measuring stiff materials, correcting for compliance can improve the results.  For torsion measurements
follow the Calibration wizard on the Settings tab of the Geometry template.  For parallel plates, the default
values are rheometer and measuring system-specific and it is recommended that you keep these values.  The
compliance correction is not available for cone and plate measuring geometries.

Finding the Zero (Datum) Point

Follow these steps to ensure that the zero point (datum) is correctly set:

1. Ensure that the air is applied and rheometer switched on.

2. Attach the required measuring geometry to the rheometer.

3. Load the Geometry file into the software.

4. Ensure that the instrument status page is active.

5. Select Instrument from the software menu.

6. Click on the Gap entry.

7. Select the Zero gap option or select the  button on the tool bar.

8. Position the measuring geometry within 5 mm of the lower plate. (Use the up and down arrows.)

9. Press the Continue button.
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Setting the Geometry Gap
The actual gap used by a measuring geometry is not the same as the zero datum point, for instance a cone is
backed away from the datum point by the truncation value of the cone.

1. Select Geometry from the menu.

2. Click on View.

3. Click on the Dimensions tab.

4. Enter the gap set value as follows:

• Cones:  Enter the truncation height (from the geometry certificate).
• Plates: Enter the required gap.
• Cylinders: Enter the gap (as specified on the geometry certificate).

Using the Backoff Distance Setting

When loading and removing samples from the rheometer, you must move the measuring geometry far enough
apart to clean both the upper (rotor) and lower (stator) parts.  The geometry file allows you to specify a backoff

distance.  This is the gap that the rheometer will go to when you press the backoff button   or select the Raise

head option from the Gap section of the Instrument menu.

Set this value so that the gap is large enough to allow sufficient clearance for cleaning and gap loading.  I t
should not be so large as to cause a significant delay when the head moves between the backoff and geometry
gap positions.

Adjusting the Rheometer Gap Velocity Values

The speed of movement of the rheometer head is controlled by the software. Three values can be adjusted.

Velocity Description

Fine velocity The velocity of the rheometer head when moving to the measuring geometry gap
and less than 10 mm above the zero point.  Above 10 mm, the Coarse velocity setting
is used.

Course velocity The velocity of the rheometer head when moving to gap and 10 mm above the zero
point.  Below 10 mm, the velocity slows to that selected as the Fine velocity.

Other velocity The velocity of the rheometer head when manually closing the gap to within 5mm
(for gap zero determination.)

To adjust these values select Instrument on the Options menu. Then click on the Gap tab.
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Programmed Gap Closure

Under the tab for Gap on the Instrument item of the Options menu, you will see the settings for Sample com-
pression.  This setting allows you to decide how the gap is actually closed (either none, linear, exponential or
normal force/stress).  This is a very important consideration, particularly if you have thixotropic materials or
samples with very delicate structure.  Sometimes the mere action of loading the sample and closing the gap can
destroy the very property you are trying to measure.  See the table below for the available settings:

  Sample Description
 Compression

None The gap is closed at a continuous velocity (as set under the Fine velocity
entry.)

Linear When the gap closes to the distance specified in the Compression distance
entry, the gap is closed at the Compression velocity value.

Exponential When the gap closes to the distance specified in the Compression distance
entry, the gap is closed at an exponentially decreasing rate. The initial velocity
is that specified in the Compression velocity entry.

Normal
force/stress Over the Compression distance, the velocity will slow at a rate proportional to

the increase in the speed of normal force build up (based upon the entry peak
normal force).

Solvent trap covers should be used if the sample is likely to dry out during a measurement or if solvent evapora-
tion will occur.  The relevant solvent is put into the solvent reservoir, once the cover is in place the free volume
between the cover and the edge of the sample is saturated with vapor.  An alternative is to "seal" the edge of the
sample with silicone grease.  However, you must ensure that the grease does not migrate into the sample.

Gap Setting Problems

If the rheometer is not performing a good gap set, consider the following points.

• Is dirt present on the measuring geometry? If so, clean it and try again.

• Is the Normal force reading out of range? Try zeroing the reading manually.

• Is the measuring geometry correctly located in the upper chuck? Try removing, cleaning the screw thread
and then re-attaching it.
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Chapter 3
Handling Files

This section provides you with information needed to open, create, and save information using the Rheology
Advantage Instrument Control program.

What are the File Types?
The software uses the following file types:

Type Description Icon Extension

Measuring geometry Form factor information for the geometry. *.argeom

Procedure, flow An entire flow procedure, all steps. *.arflow

Procedure, oscillation An entire oscillation procedure, all steps. *.arosc

Procedure,creep An entire creep procedure, all steps. *.arcreep

Notes Sample notes. *.arexpnotes

Results Generated data. *.rsl

Session Saved sessions *.ssar

Graph Graph style settings *.graphset

Options, Instrument Instruments options *.arinsopts

Options, Experiment Experiment options *.arexpopts

Instrument Rheometer specific information. *.arinstr

•  Measuring geometry files:  You must create a geometry file for each measuring system you have.  You
can also create separate files for the same geometry if, for instance, you wish to use different gap values or
other settings.

(continued on next page)
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• Procedure files:  Procedure files contain the information required to run tests. Flow, creep and oscillation
procedure files are distinguished by a different extension as well as using a different colored icon for each
type.

Flow procedure files have the extension ARFLOW

Creep procedure files have the extension ARCREEP

Oscillation procedure files have the extension AROSC

•  Notes file:  All the information that you place in the Experiment notes section of the software is stored

in a notes file.

•  Results file:  All data generated by the software can be saved as a results file. The file extension is the
same, no matter what type of procedure was used to generate the data.

•  Session files:  Session files allow you to record all information active in the instrument software. A
session file contains the following information:
— Measuring geometry
— Procedure
— Notes
— Instrument settings
— Options.

•  Graph settings files:  The software allows you to create one or more "standardized" layouts for your
graphs.  These template files are stored as "Graph settings files" by use of the Styles tab (shown below) on
the Graph properties.

•  Instrument files:  These files contain the serial port (comms) information required to connect to an
instrument. A descriptive name is also stored in the file.   Instrument files have the extension ARINSTR.

Choosing Filenames
To make it easier to find files, you can use long, descriptive filenames. The complete path to the file, including
the drive letter, server name, folder path, and filename, can contain up to 255 characters.  Filenames cannot
include any of the following characters: forward slash (/), backslash (\), greater than sign (>), less than sign (<),
asterisk (*), period (.), question mark (?), quotation mark ("), pipe symbol (|), colon (:), or semicolon (;).
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Opening/Copying Files
You can open files from many different locations using the Open item under the Geometry, Procedure,  and
Notes menu items in the program.  You can open a file on your computer hard disk or on a connected network
drive.  You can also open a file on a network, even if you don't have a connection to a network server, as long as
your network supports UNC addresses.

1. Select Open... in the Geometry, Procedure, or Notes menu item.

2. Click the arrow next to the Look in box and locate the drive, folder, or Internet location that contains the
desired file.

3. Click the file type you want in the Files of type box.

4. Double-click any folders until you open the folder that contains the file you want.

5. Double-click the file you want to open or select the file and click Open.

Opening a File Using a UNC Address

1. Select Open... in the Geometry, Procedure, or Notes menu item.

2. Click the file type you want in the Files of type box.

3. Type the UNC address for the network share containing the file that you want in the File name box.  Press
ENTER.  For example, type \\Computer1\Files to open a file on the server Computer1, on the share Files.

4. Double-click any folders until you open the folder that contains the file you want.

5. Double-click the file you want to open or select the file and click Open.

Opening a Rheology Solutions File

1. Select Open... in the Geometry, Procedure, or Notes menu item.

2. Click the arrow next to the Look in box and locate the drive, folder, or Internet location that contains the
desired file.

3. Select the Version 1 option in the Files of type box.

4. Double-click any folders until you open the folder that contains the file you want.

5. Double-click the file you that want to open or select the file and click Open.

Creating a Backup Copy of a File

1. Select Open... in the Geometry, Procedure, or Notes menu item (depending on what you wish to back up.)

2. Select File/Save As...

3. Choose a location and type in a name for the backup file.

4. Click the Save button.
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Using the File Property Information
File properties are details about a file that help identify it—for example, a descriptive title, the author name, the
subject, and keywords that identify topics or other important information in the file.  You can set file properties
for any Rheology Advantage file.  You can also create custom file properties relevant to your own products or
information handling routines.

The following are the types of file properties:

• Pre-set file properties:  These are properties such as author, title, and subject that already exist for you to
enter a value.

• Custom file properties:  You can create custom file properties that include any value you assign.  For
example you could create a custom file property to use in all QC Verification files.

• Automatically updated file properties:  Statistics such as file size and the dates files are created and last
modified are file properties that are automatically maintained for you.  These file properties help you
search for all files created after a certain date, such as March 3, 1996, or last modified yesterday.

Viewing the Property Information
To view the file property information for an already loaded file, follow these steps:

1. Click on Geometry, Procedure, or Notes on the menu.

2. Select Summary information.

To view the file property information for a stored file, follow these steps:

1. Select File/Open... from the menu or click the  button.

2. Click the arrow next to the Look in box and locate the drive, folder, or Internet location that contains the
desired file.

3. Select, then right click the file you want to view file properties for.

4. Select Properties from the pop-up menu.

5. Click on the tabs to see specific information.



Rheology Instrument Control Getting Started Guide 35

Adding/Editing the File Properties
To add or edit the file property information for an already loaded file, follow these steps:

1. Click on Geometry, Procedure, or Notes on the menu.

2. Select Summary information.

3. Add or change the properties on the Summary tab.

To add or edit the file property information for a stored file, follow these steps:

1. Select File/Open... from the menu or click the  button.

2. Click the arrow next to the Look in box and locate the drive, folder, or Internet location that contains the
desired file.

3. Select, then right click the file you want to set file properties for.

4. Select Properties from the pop-up menu.

5. Add or change the properties by selecting the options you want on the Summary and Custom tabs.

Creating Custom File Properties

1. Select File/Open... from the menu or click the  button.

2. Click the arrow next to the Look in box and locate the drive, folder, or Internet location that contains the
desired file.

3. Select, then right click the file you want to set file properties for.

4. Select Properties from the pop-up menu.

5. Click the Custom tab.

6. Type a name for the custom property in the Name box or select a name from the list.

7. Click the type of property you want in the Type box.

8. Type a value for the property in the Value box.  The value you enter must match the selection in the Type
box.  For example, if you click Number in the Type box, you must type a number in the Value box.  Values
that don't match the property type are stored as text.

9. Click the Add button.

10. Click the OK button.
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This chapter provides the information needed to operate your rheometer using the Rheology Advantage Instru-
ment Control program.  In order to run the instrument you will need to design a test, set up and operate the
rheometer and make sure that you have achieved accurate temperature control.  In addition to the information
already described, this chapter also provides you with the instructions needed to remove  the air bearing clamp,
level the rheometer, and manually operate the instrument.

Designing a Test
When using the rheometer to analyze test samples, the most common method used to obtain results is by
creating or editing procedures.  This section deals with the concepts of test design.

What Steps are Involved?
A procedure consists of one or more steps that are executed in sequence. Each step can be made to conditionally
end, if required.  The following is a description of the types of steps that can be used in a procedure.

• Conditioning step:  Use this step to ensure that the sample is at the correct temperature and any residual
normal force (from loading) is at an acceptable level.  You can then "pre-condition" the sample.  This
allows you to apply a shear to remove any history associated with the sample preparation, storage and
loading.  Additional conditioning steps can be included in your procedure.

• Main procedure steps:  In between the (optional) conditioning and post-experiment steps, you can define
one or more main procedure steps, which can be of any type and in any order.

• Conditional step termination:  The program allows you to define conditions in which a step is halted
ahead of its normal termination conditions.  You can use this to ensure that, for instance, the instrument
does not over speed or apply excessive strains.

Rather than running a step for a certain amount of time, you may wish to run it until stable data is
obtained. You can set an equilibrium limit (such as the viscosity value becoming constant when running a
single shear with time) that will stop the currently active test.

• Post-experiment step:  You can set the temperature system to idle.  You can also get the rheometer to head
towards a new temperature.  This can be handy as an aid to cleaning the rheometer.

Chapter 4
Operating the Instrument
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Available Flow Steps
The following steps are available in the Test type option for flow mode:

If your instrument has a normal force transducer, the squeeze/pull off test will also be available.  In this test the
upper geometry is either raised or lowered at a constant speed and the force is measured.

Continuous
Continually ramps the shear
and samples at defined intervals.

Peak hold
Holds the shear constant and
samples at defined intervals.

Steady state flow
Applies successive shear values.
Data sampled under equilibrium conditions.

Stepped flow
Applies successive shear values.
Data sampled at end of each value.

Temperature ramp
Holds the shear constant
while rampling the temperature.
Samples at defined intervals.



Rheology Instrument Control Getting Started Guide 39

Available Creep
Steps
The creep test function is shown to the
right.

Available Oscillation Steps
The following steps are available in the Test type option for oscillation mode:

Strain/Stress Sweep
Applies a fixed frequency
and increments the amplitude.

Frequency Sweep
Applies a fixed amplitude
and changes the frequency.

Temperature Ramp/Time Sweep
Applies a fixed frequency with a set
amplitude.  Monitors viscoelastic
properties as a function of
time/temperature.

Time/Temperature Sweep
As per ramp, but applies a sequence
of discrete temperature steps rather
than a smooth ramp.

Retardation   Recovery

Maximum
step time.
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Available Stress Relaxation
Steps (AR 2000 Only)
The stress relaxation or step strain test is shown to
the right.
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Manually Operating the Rheometer
When the Instrument Control program displays the Instrument Status page you can manually set and control
the following aspects of the rheometer.  You can access the parameters to set from the Instrument menu item by
clicking on the appropriate icon or by clicking on the grid.

• Set Temperature
• Set Stress/Torque
• Set Rate/Speed
• Set Strain (AR 2000 Only)
• Zero Strain
• Zero Normal Force.

There are a number of gap controls that can also be accessed from the Instrument Status page:

• Raise head (to back off distance)
• Go to geometry gap
• Enter gap
• Zero gap
• Stop head
• Up and down.

Rotational mapping, normal force control, and bearing lock/release (AR 200 only) can also be accessed from the
Status page.

Display Raw (Point)
Data During a Test
Use the following steps to display the point graph for Oscillatory and steady state flow procedures.

Displaying Data for a Flow Procedure

1. Select Options from the menu.

2. Click on Experiment.

3. Click on the Flow tab.

4. Select the option Display point graph during run.

5. Click on the OK button.

Displaying Data for an Oscillation Procedure

1. Select Options from the menu.

2. Click on Experiment.

3. Click on the Oscillation tab.
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4. Select the option Display waveform during run.

5. Click on the OK button.

The point graphs can also be saved to disk and be viewed on a point-by-point basis in the data analysis pro-
gram.
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session 31
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flow
inertia correction 19
procedure files 31
test steps 38
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controlling 25
programmed closure 29
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files 31
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files 32
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Help 7
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tool bar 13

files (cont'd)
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I

inertia
calibrating 18
measuring system 18

instrument. See rheometer
files 31, 32

Instrument menu 14

instrument option
files 31

L

logarithmic. See also Log

M

main procedure steps 37

manuals
printing 8

mapping
automatic prompting 21
rotational 20
torque 20
types 20

measuring geometry
files 31

measuring system
inertia 18

menu
Experiment 15
File 14
Instrument 14
Options 15
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notes
files 31, 32

Notes, Cautions, and Warnings 6
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offset values
determining 23
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open
files 33
files using UNC address 33
Rheology Solutions files 33

Options menu 15

oscillation
procedure files 31
steps 39

P

Post-experiment step 37

Pre-set file properties 34

preparation
for testing 17

procedure
files 32

properties
automatically updated 34
files 34

adding 35
viewing for files 34

R

remote key. See also system key

results
files 31, 32

Rheology Solutions
files 33

rheometer
calibrating 17 to 29

inertia 18
controlling gap 25, 29
designing tests 37
displaying raw data 41
head

velocity of 28
operating manually 41
preparing 17
setting gap 28, 29
speed of head 28
system verification 25
thermal compensation 26

rotational mapping 20 to 21



Rheology Instrument Control Getting Started Guide48

S

samples
compressing 29
removing 28

ScreenTip 7

session
files 31

size
buttons 13

software
configuring 12

span value 23
calibrating 23
determining 23

step strain test 40

stress relaxation steps (AR 2000) 40

stress relaxation test 40

system verification 25

T

temperature
calibration 22

temperature control system
calibration 22

tests
designing 37
steps 37

conditional step termination 37
conditioning 37
creep mode 39
flow mode 38
main procedure 37
oscillation 39
post-experiment 37

thermal compensation 26
table of values 26, 42

tool bar
button size 13
experiment run 11
hide/show 13
main 9
moving 13
standard 10
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tool bars 13

torque mapping 20

V

verifying
the rheometer function 25

Z

zero point 27
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